
IOTA Video Application

November 25, 2016

Table of Contents

1  Introduction............................................................................................................................................1
2  Installation..............................................................................................................................................2
3  Start Up..................................................................................................................................................2
4  Application Windows.............................................................................................................................2

4.1  Display Window..........................................................................................................................2
4.2  User Messages Window.............................................................................................................5
4.3  Video Recording Window...........................................................................................................6
4.4  Dialog Windows.........................................................................................................................6

4.4.1  Devices...............................................................................................................................6
4.4.2  Scheduling An Event...........................................................................................................7
4.4.3  Editing And Deleting Events................................................................................................9
4.4.4  Event Pending Window.......................................................................................................9
4.4.5  Setting The Codec............................................................................................................10
4.4.6  File Defaults......................................................................................................................11
4.4.7  Pixel Saturation.................................................................................................................11
4.4.8  Performance.....................................................................................................................12
4.4.9  Frame Integration.............................................................................................................13

5  Digital Video Cameras.........................................................................................................................14
6  Release History....................................................................................................................................14

6.1.1  Computer Clock Drift........................................................................................................14

1 Introduction

The IOTA Video Application targets the needs of the user performing an occultation at a mobile location.  The 
user interface is designed for smaller displays by dividing the application into multiple windows, primarily a main 
window that displays the video and has a menu bar, a controls window with large buttons that are easily 
activated either by mouse or touch screen, and a user messages window that displays relevant information.  The
user can perform manual recording or timed recording, the latter permitting unattended recording.

The rationale for the development of this application goes beyond targeting the IOTA member as an end user.  A 
key factor is that the source code belongs to IOTA, which means that as the operating environment changes the 
code can be updated by an IOTA member to reflect the new situation.  Applications used by IOTA members that 
have been developed many years ago and no longer supported may not run under the latest version of the 
Windows operating system, sometimes forcing users to stick with older versions of the operating system.  Issues
like this are removed when IOTA owns the code.

An example of a future enhancement is that as newer digital cameras with fast frame rates become available, 
application support for the camera driver can be added.  Another example is the development of a custom filter 
that can capture video stream information in real time and analyze and/or store the information as needed.
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2 Installation

Application development is based in the Visual Studio Community IDE.  As a result it targets the Windows 
operating environment, specifically Windows 8.1.  Applications developed in the Windows 8.1 environment also 
run in Windows 10.  The application may run in other windows environments such as Windows 7, but no 
extensive testing has been done to verify other environments.

The application is delivered as a self installing executable.  The install executable name depends on the 
application version number, and is “IOTA_VideoAppInstall_vxxx.exe” where the xxx is replaced by the version 
number.  If the executable is delivered as an e-mail attachment, then the file name will have “.sav” appended to 
the end in order to pass through an e-mail security system.  Upon saving the executable file in a local directory, 
you must remove the “.sav” extension.

To start the install process, simply run the self installing executable, typically by double clicking the file name.  
The Windows OS will ask if it is OK to let the install process make changes to your computer.  Either answer yes 
if you want to continue with the install, or no to exit the install.  The IOTA Video Application can be installed in a 
folder of your choice or you can use the default folder.

IMPORTANT: this is the first release of a self installing executable and it is no longer dependent on the download
of a Visual Studio runtime environment.  To prevent conflicts with the previous release, install this release into an
empty directory.  Future releases are expected to not have this restriction.

3 Start Up

You can typically start up the IOTA Video Application without paying much attention to start up variables, that is, 
the application windows will simply appear on the display and you can then do the normal set up for recording an
occultation.  However, the first time the application is started there might be a need to pay attention to special 
circumstances due to the fact that the variables that represent application configuration have not been saved in 
an options file.  In particular, one of the most important aspects of the first time start up is the positioning of the 
application windows.  Some computers have small display screens and this presents problems with the 
placement of the application windows.  The window of particular importance is the main application window that 
contains the video display.  This window will always be placed within the boundaries of the display screen the 
first time the application is started.  You should then find all the start up windows, place them on your display 
where you would like them to start up in the future, and save the windows positions (options will be discussed 
below).

4 Application Windows

Use standard Windows mechanisms to start the application, for example by double clicking on the desktop icon 
or double clicking the ".exe" file in File Explorer.  This action will pop up an initial splash screen followed by three
windows.  The first window is the display window which as mentioned in the introduction contains a menu bar.

The second window is for user messages.  It displays information relevant to the operation and precedes each 
piece of information with the current UTC time.  Current local time is never shown; however, the first message 
displayed is the time zone setting for the computer.  The "File" menu on the menu bar is used to save the user 
messages to a log file.

The third window to pop up is an event recording controls window containing buttons that can control the 
application.  The two control buttons used are to start and stop video recording.  If there are no video devices 
attached to your computer, this window will not appear.

There are other windows that will pop up during various user activities.  These windows are described below in 
the appropriate sections.

4.1 Display Window

The Display Window contains an embedded window that shows the video from the current video capture device. 
It also contains a menu bar with five menus that provide interfaces to most of the user tasks.
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The File menu has only one sub-menu, which is "Exit".  This menu will expand as the IOTA Video Application 
incorporates additional capabilities.

The Events menu has two sub-menus.

The "Schedule..." sub-menu permits scheduling an occultation event.  The "Edit and Delete..." sub-menu 
provides editing capabilities of existing scheduled events along with the ability to delete events.
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The Display menu has four sub-menus.  All Display sub-menu selections affect only what is seen in the display 
window.  They do not affect what is captured in the video recording stored on disk.

The "Brightness/Contrast" selection pops up a dialog that controls the brightness and contrast of the video 
display.  If the dialog is displayed, the "Brightness/Contrast" sub-menu has a check mark to the left.  To close the
dialog the user either re-selects the sub-menu (which then closes the dialog and removes the check mark) or 
selects the 'X' in the upper right corner of the “Brightness and Contrast” window.  If there are no attached video 
cameras, this sub-menu is deactivated.

“Pixel Saturation...” allows setting a value such that if any pixel in the video display exceeds or matches the 
value the pixel is displayed with a special color.  The special color (magenta) is one that is not seen in a star 
image and thus should stand out in the video display.

“Computer Clock Drift...” is discussed in a special section at the end of this document.

“Frame Integration...” provides software integration of consecutive frames from the video camera.  It can be 
considered supplementary to the brightness/contrast feature and it is possible to use both features at the same 
time.  If there are no attached video cameras, this sub-menu is deactivated.

The “Pixel Saturation...” and “Frame Integration...” features cannot be used at the same time and the user 
interface prevents that from happening.  If using both at the same time becomes important to the user 
community, an enhancement request will place it in the application requirements document.

It is worth mentioning again that the Display features listed above DO NOT modify the video captured in the file 
stored on disk.

The Options menu has seven sub-menus which when selected may cause information to be stored in an options
file (the “Pixel Saturation...” feature described above may also store information in the options file, but it is better 
placed under the Display menu).
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"Devices..." permits selection of a video capture device if there is more than one attached to the computer.  If 
there are no attached video capture devices, this sub-menu is deactivated.

"File Defaults..." allows for storage of generated files to disk locations other than the default locations and 
permits adding a prefix to the default file name.

"Duration Default..." permits setting a default recording duration.  When an event is scheduled, the user dialog 
starts with the default recording duration.  That value can be modified when scheduling an event, or it can be 
modified with this sub-menu so that scheduling an event starts with the new default value.  If the value in the 
"Duration Default..." dialog is never set, the system value is 10 minutes.

"Codec Default..." is used to pair a specific codec with a camera.  If a pairing is created, that codec is used when
a video file is created for storage to disk.  The codec used with a camera can be changed any time prior to the 
start of a recording.  If there are no attached video cameras, this sub-menu is deactivated.

"Event Pending..." has two selections which change the way an event countdown window is displayed.

“Performance...” is a selection that is normally not used unless you are dealing with hardware that has below 
average video capture capabilities.

"Set Windows Positions" captures the positions of the windows on the display monitor and stores the values so 
that the next time the application is started the windows will appear at the captured positions.  The position of an 
iconified window is not captured.

Selecting Options sub-menus that are followed by "..." pops up a dialog window for additional user interaction.  
Some of the dialogs merit further discussion and are described later in this document.

4.2 User Messages Window

This window is for displaying relevant information to the user.  It has a menu bar with one menu, namely "File".  
The "File" menu has two sub-menus, "Save Messages" and "Save Messages and Clear".  The "Save Messages"
selection saves the contents of the window to a file with a ".log" extension.  It leaves the contents of the window 
intact.  In contrast, the "Save Messages and Clear" selection also creates a log file with the window contents but 
then deletes the window contents.
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4.3 Video Recording Window

Video recording, which means capturing the camera video to a file stored on disk, can be started manually or by 
a scheduled event.  When the application is activated with an attached video camera, another window called 
"Event Recording Controls" is displayed.

The window has two control buttons whose icons the same shape that is seen on a typical VCR or DVR, namely 
start recording and stop recording.  If the start recording button is selected, the video stream seen in the display 
window is now being captured to a disk file.  If no options have been previously specified, then the video file is 
given an application default name and stored in a default directory.  Selecting the start recording button 
deactivates it and the stop recording button is activated.

4.4 Dialog Windows

Dialog windows appear when the text of a sub-menu ends with “...”.  The dialogs require that the user enter 
specific information, and it must be closed by the user selecting “Cancel”, “OK”, “Save”, or “X” in upper right 
corner before the Display Window becomes interactive once again.  Some of the dialog windows are described 
below where some additional information is useful.

4.4.1 Devices

The normal use of the “Devices...” sub-menu is for selecting a specific video capture device attached to the 
computer, which applies only if there are multiple attached capture devices.  Otherwise the application will select 
the only attached capture device (if there is one) and display the video from that device in the main display 
window.  The format of the device display, namely the frame size and frames per second, is initially decided the 
first time the application is started.  The application applies device defaults to known, supported devices, for 
example, “USB 28xx” devices.  Application users should typically use the defaults, but there may be special 
circumstances where a user may want to use other selections.  To see possible format selections and to not 
modify set driver properties to standard values, the user can uncheck the “Use defaults for known devices at 
application startup”, press the “Save” button (“OK will change to “Save”), and restart the application.

The formats shown in the formats list box depend on the analog video format type, namely NTSC and PAL.  A 
device may support both types, one of the types, or in some cases neither type, in which case nothing is shown 
in the list box.  When selecting the “Devices...” sub-menu under the “Options” menu the following dialog pops up.

6



When the dialog first pops up the highlighted video capture device is the one that is displaying video in the main 
display window.  If a device has a check mark it means that it is the default camera in the options file.  In this 
example dialog the formats shown are those available for 30 frames per second (NTSC).  As with the Devices 
list box, the highlighted format in the Formats list box is the one used in the main display window.  If a format has
a check mark it means that it is paired with the selected camera as the format of choice in the options file.

The values in the Formats list box represent the width x height in pixels of the video display.  For some devices 
different formats might mean that the same picture is expanded or compressed to fit within the width x height 
values, and for other devices it might mean that more or less of the same camera image is displayed in the main 
display window.  In the above dialog, changing the selection to the 720x480 format will stretch the width of the 
display from 640 to 720 and leave the height as is.  Thus, although the same picture is shown, it is stretched 
horizontally.  If a format is paired with the highlighted device in the options file, the format will have a check mark.
Thus a highlighted format may or may not be the one with a check mark.

Although a device may present many formats, some of the formats may not actually be valid and will not present 
video to the main window display.  One indication is that when a new format is selected and “OK” is pressed, the 
User Messages window will show an error message.  Another indication is that the main display window will 
show a gray background even though there is no error message.  In either case, re-select the “Devices...” sub-
menu and choose a different format.

If the check box “Use highlighted selections as application startup defaults” is checked, the “OK” button text will 
change to “Save”.  If then the “Save” button is pressed the highlighted entries for the Devices and Formats list 
boxes will be saved as defaults in the options file.

4.4.2 Scheduling An Event

Manually recording an occultation event requires the user to be present to start and stop the recording.  This can
be inconvenient for many reasons and points to a need for scheduling the recording period around an event.  
Under the "Events" menu mentioned above there is a sub-menu "Schedule..." that when selected pops up the 
following dialog.
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The above dialog starts with the "Event Date and Time (UTC)" filled in with the current date/time from the 
computer.  The Recording Duration is filled in with the value set using the "Duration Default..." Option sub-menu, 
or the application default value of 10 minutes if the duration option was never entered.  Now the actual event 
date/time can be entered.  IMPORTANT NOTE: the value entered represents the midpoint of the recording 
interval.  For example, with a recording duration of 10 minutes the recording will start 5 minutes prior to the 
"Event Date and Time (UTC)" and end 5 minutes after.

An optional comment can be added to the scheduled event, which can be useful for a later review of the 
scheduled events or serve as a reminder of what has already been recorded by expired events.

There are two check-boxes for hibernation or shutdown of the computer after the event recording is complete.  
This might be useful for recording an event on a laptop with an internal battery as its only power source.  Only 
one of the two check-boxes can have a check mark.  If a box is checked, then upon completion of the recording 
a dialog will pop up that gives the user 30 seconds to stop the hibernation or shutdown.  If not stopped within the
allotted time then the computer is placed into hibernation or is shut down.

Sometimes hibernation is not supported on a computer, and if that is the case there is a user message upon 
application startup that indicates lack of support.  It is recommended that you test hibernation capability prior to 
using your computer in the field for a real event recording.  It is possible that there might be no message about 
lack of hibernation support even though it is indeed not supported on a specific computer.

The shutdown choice initiates a timed computer shutdown (after the 30 seconds expires) and a video application
exit.  The timed shutdown closes all open applications and provides one last chance to prevent a shutdown.

If the Save button is selected, the event is stored in a file with a ".ief" extension in the "Events" sub-folder in the 
same directory as the application executable.  The file is in XML format and can be examined using Notepad 
(avoid WordPad).  Although it is easy enough to modify the file contents, it is recommended that you use the Edit
capability (discussed next) for modifications in order to avoid errors.
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4.4.3 Editing And Deleting Events

All events can be reviewed by selecting the "Edit and Delete..." sub-menu of the "Events" menu.  The following 
dialog pops up.

In the above dialog the "Show Expired Events" checkbox is checked, and thus the dialog shows one expired 
event and three events yet to occur.  Of the events yet to occur, one will hibernate the computer and another will 
shut down the computer upon recording completion.  If one of the events is selected, the "Edit Selected Event" 
button is activated, which pops up the Schedule Event dialog shown earlier in this guide.  If one or more events 
are selected, the "Delete Selected Events" button is activated.  If this button is pressed, any selected events are 
immediately deleted - there is no "are you sure" message.  Thus you might want to consider backing up the 
events directory before doing deletes.  As mentioned previously, scheduled events are stored in the "Events" 
subfolder under the folder in which you have placed the application executable.  Event files have an extension 
".ief" which is short for IOTA Event File.

4.4.4 Event Pending Window

If there is an event scheduled for the future (i.e. not expired) and a video camera is attached, then an Event 
Pending window is displayed.
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As shown above the window contains a countdown field that shows how much time remains until event recording
is started.  In this case the recording duration is 10 minutes so that the start time is 5 minutes before the event 
time, and the end of recording is 5 minutes after the event time.  An alternative to showing a countdown timer is 
to show the current UTC time.  In order to do that there is the "Event Pending..." sub-menu under the "Options" 
menu, which when selected pops up a dialog that allows you to change what is displayed in the above Event 
Pending window.

If the Event Pending window is displayed because there is a scheduled event, then selecting the "Set Windows 
Positions" sub-menu under the "Options" menu will capture the position of the Event Pending window (along with
all the other displayed windows) and save it in the options file so that the next time the window pops up it will 
show up in the saved position.

4.4.5 Setting The Codec

For each camera attached to the computer and recognized by the application as a video capture device it is 
possible to set a default coded used when recording the video to a disk file.  When selecting the "Codec 
Default..." under the "Options" menu the following dialog pops up.

The dialog is based on the current camera in use, which in this case is the USB 2820 Device.  This is the 
designation given to the camera attached to the computer when using the StarTech SVID2USB2NS hardware 
that plugs into a USB port.  The highlighted entry in the dialog above is the codec in current use.  If there is a 
check mark next to the entry, then the entry has been paired with the camera in the options file.  Thus the 
highlighted entry above is also the paired entry.  If no entry has a check mark next to it, there is no pairing in the 
options file.  That can be remedied by selecting the codec of choice and checking the "Pair highlighted codec 
with camera as application default" check-box.  When the check-box is checked the "OK" button switches text to 
"SAVE", and pressing the button saves the choice to the options file.

In the dialog above it shows that the Lagarith Lossless Codec is paired with the USB 2820 camera.  NOTE: it is 
important to install and use the Lagarith codec or some other lossless codec because using no codec will 
generate enormously large files during video recording.  Even using the Lagarith codec generates large files, but
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they are manageable.  With the Lagarith codec a 10 minute recording might typically generate a 2 to 4 GB file.

4.4.6 File Defaults

It was stated previously in this user guide that if no options are set that a video recording will be stored in a 
application default folder using an application default name.  That situation can be modified by selecting the "File
Defaults..." sub-menu under the "Options" menu which causes the following dialog to pop up.

The dialog has two embedded groupings, one group for setting Video file defaults and the other for setting User 
Messages log file defaults.  The video file grouping has been given a file prefix "Video_" and thus the file name is
indicated below as Video_mm_dd_yyyy_hh_mm_ss.avi.  If no prefix had been entered, the file name would 
instead be mm_dd_ etc., which is the application default.  The "E:\Video_Files\" entry was entered by selecting 
the folder icon just above the entry.  If you later decide to use the application default location you can clear the 
entry by selecting the folder icon that has the small circle enclosing an 'x'.  The same user interaction concepts 
apply to the User Messages log file defaults.

4.4.7 Pixel Saturation

This feature permits the user to determine if the video camera sensitivity is too high for the occultation recording 
situation by displaying pixels which have reached the saturation limit.  If the user selects the “Pixel Saturation...” 
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sub-menu under the “Options” menu the following dialog pops up.

When the above dialog is displayed, the video display has pixel saturation enabled.  The slider bar on the dialog 
can be moved to see if any pixels are saturated according to the value set by the slider.  If the “Brightness and 
Contrast” window is activated, the values set by that window do NOT affect whether or not a pixel is saturated.  
Technically it means that the saturation filter is placed before the brightness/contrast filter in the video display 
stream.

If “OK” is selected without placing a check mark in either check-box, then the dialog is closed and the pixel 
saturation value remains in effect.  If the “Use pixel saturation value as default” check-box is checked, then the 
“OK” button text changes to “Save”, and if then “Save” is selected the pixel saturation value is saved in the 
options file.

If the options file has a pixel saturation value, then upon application startup the pixel saturation capability is 
enabled.  If this is no longer desired, then placing a check mark in the “Remove pixel saturation checking” check-
box and selecting “Save” will immediately disable saturation checking.

4.4.8 Performance

This feature can be used when the computer hardware used to execute this application drops frames when 
capturing video to a disk file.

One strategy is to use file pre-allocation, which causes the video file size to start with a given size prior to the 
start of recording.  Its usefulness is dependent on the disk hardware / software capabilities of your specific 
computer.

Another performance strategy is to select a different Microsoft video renderer besides the default, which is the 
Enhanced Video Renderer (EVR).  Two other renderers are provided, namely the VMR9 and VMR7 renderers.  
The EVR is the future direction for Microsoft, but it can be a performance hog if certain hardware support is not 
provided.  It is possible that using one of the other two renderers might solve the dropped frames issue for 
specific computers.
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The strategy most likely to succeed is to turn off the display while recording.  Of course you cannot see any 
display updates while the recording is occurring, but for unattended operation this makes no difference.

There are other things to try besides those shown on the above dialog.  If you Google “dropped video frames” 
you will find links to articles that discuss how to prevent them.  An important strategy is to prevent most interrupts
from occurring while you are recording, which might typically involve disabling your internet connection and 
stopping unnecessary background processes.

4.4.9 Frame Integration

The Frame Integration feature can normally be ignored except under circumstances where a target star is simply
too dim to be seen in the display window, even after using the brightness/contrast feature.  Frame integration will
overlay a specified number of frames on top of each other and then start over with the next set of frames.  If you 
select “Frame Integration...” under the “Display” menu, the following dialog pops up.
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You can enter from 2 to 30 frames to be overlaid.  The bigger the number the more easily seen are the dim stars.
A drawback to bigger numbers is that background noise also becomes more apparent, thus the the process of 
finding dim stars might take some experimentation.  For the truly interested user, the “Show histogram in User 
Messages” can be checkmarked, and a histogram showing the number of pixels in the dark background frame 
(which is the first frame after “Start” is pressed), is sent to the User Messages window.  Just before pressing the 
“Start” button, you should cover the camera with a lens cover, and can then take it off after the first frame is 
capture (wait a couple seconds).

The Frame Integration dialog will remain on the display screen until you press the “Exit” button.

5 Digital Video Cameras

The IOTA Video Application currently supports only analog video cameras, but the hardware trend is towards 
digital video cameras.  Some IOTA members have already installed and used digital video cameras on the same 
computers that they run the IOTA Video Application.  Sometimes the application may show a digital video 
camera as a possible selection when the camera is plugged into a USB port and the user selects the “Devices...”
sub-menu under the “Options” menu, but sometimes it will not.  It depends on the characteristics of the installed 
driver.  There is no guarantee that any application capabilities will work for digital video cameras.  Support for 
these devices is planned for 2017.

6 Release History

➢ Version 1.0,  July 25, 2016

➢ Version 1.1,  November 25, 2016

• Add pixel saturation feature

• Support StarTech device with audio input – note that only the video input is captured

• Add “Performance...” sub-menu under “Options” for use when computer is dropping frames

• Add “Display” menu and move the “Brightness/Contrast” feature as a sub-menu

• Add “Help” menu.  In this release all it does is display the application version to User Messages.

• Prevent computer from going to sleep or into hibernation during an Event countdown

• Prevent multiple instances from running on the same computer

• Add splash screen

• Add “Frame Integration...”  feature under the “Display” menu

• Add installation setup executable

Temporary Section to describe Clock Drift Measurement

6.1.1 Computer Clock Drift

This feature really belongs under a “Tools” menu rather than the “Display” menu because it is not a modification 
to the display stream.  In fact, while the feature is running the video display stream is turned off for performance 
reasons.  But for now the feature remains under the “Display” menu until such time as it becomes more 
formalized (rather than discarded), plus at the moment there are no other features to be placed under “Tools”.

If you select “Computer Clock Drift...” under the “Display” menu, the following dialog pops up.
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The feature measures the number of milliseconds per minute that the computer clock drifts when averaged over 
multiple minutes.  Although the minimum number of minutes for the measurement is listed at 3 in the above 
dialog, you should really not use a number less than 5 for a reliable measurement.  The value 3 is used for those
users that want a quickie measurement.

In order to measure the clock drift, a comparison between the IOTA VTI time and the computer clock time for 
every video frame is stored in internal memory.  Thus for a frame rate of 30 fps and a minutes value of 10, there 
are 18,000 stored comparisons.  At the end of the drift measurement the comparisons are analyzed to obtain the
computer clock drift value using a least squares fit of the data.

The IOTA VTI time for any single frame is captured using Optical Character Recognition (OCR), and in order to 
do that the software must know the placement of the VTI time overlay.  That is the reason for the two check 
boxes in the above dialog.  The VTI time overlay position moves about depending on the switch setting for “TV 
Safe” or “Full Screen” and whether or not there is a powered on video camera providing input to the VTI.  Please
note that the video camera input has been tested to work with only one camera, namely a PC165DNR, so do not
be surprised if it doesn't work for your specific camera.  Your best bet for OCR to work is to not have an attached
camera.

Doing OCR on the VTI time overlay at 30 fps is fairly compute intensive.  Although a typical desktop computer 
purchased within the last couple years will handle the load, some devices cannot.  For this reason the video 
display is turned of during the drift measurement.  In order to reassure you that progress is being made during 
the measurement, a report of the number of measured frames is sent to the User Messages window 
approximately every 20 seconds.  If a report is not received every 20 seconds or so the drift measurement is 
unreliable.  A slowdown in the report interval can occur if the computer becomes overburdened, thus a good 
reliably check for the drift measurement is if each reported frames measurement occurs with a regularly spaced 
time interval, checked for example with a wristwatch.  An obvious future enhancement is to report the time 
spacing since the last report.

When the OK button is pressed, the App will spend the first second attempting to read the VTI overlay.  If the 
conditions specified on the dialog are not met, the App will send a message to the User Messages window 
stating the problem, thus you should quickly know if it is not working.  At the end of the drift measurement an 
analysis of the stored comparisons is reported in a file named “TimeDeltas.txt” and placed in the process 
directory.  The file should be opened with Notepad to view its contents.

The clock drift measurement feature is part of a longer term goal to determine if it is possible to get a reasonably 
accurate (within 1/100 second) time measurement for every video frame within a 10 minute recording period 
without the use of a VTI.  Due to the timing vagaries of input to a Windows computer via a USB port the goal 
may not be possible, but it is worth a try.  Stay tuned.
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